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CAUI-4 Automated Testing—At a Glance

The Keysight D9010CAUC CAUI-4 Test Application is an Ethernet test solution that covers the 
electrical timing parameters for CAUI-4 specification (IEEE 802.3bm).

The Keysight D9010CAUC CAUI-4 Test Application:

• Lets you select individual or multiple tests to run.

• Lets you identify the device being tested and its configuration.

• Shows you how to make oscilloscope connections to the device under test.

• Automatically checks for proper oscilloscope configuration.

• Automatically sets up the oscilloscope for each test.

• Provides detailed information for each test that has been run and lets you specify the thresholds 
at which marginal or critical warnings appear.

• Creates a printable HTML report of the tests that have been run.

NOTE The tests performed by the Keysight D9010CAUC CAUI-4 Test Application are intended to provide a 
quick check of the electrical health of the DUT. This testing is not a replacement for an exhaustive test 
validation plan.
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Required Equipment and Software

In order to run the CAUI-4 automated tests, you need the following equipment and software:

Hardware

• Use one of the following Oscilloscope models with a minimum bandwidth of 63GHz or above. 
Refer to www.keysight.com for the respective bandwidth ranges.

• Keysight DSO / DSA Z-Series Oscilloscopes

• Keysight UXR Oscilloscopes

• N5234A Network Analyzer (43.5 GHz) - required for up to 30 Gb/s return loss testing

• Keyboard, qty = 1, (provided with the Keysight Infiniium oscilloscope)

• Mouse, qty = 1, (provided with the Keysight Infiniium oscilloscope)

• Keysight also recommends using a second monitor to view the test application

Software

• The minimum version of Infiniium Oscilloscope Software (see the Keysight D9010CAUC CAUI-4 
Test Application Release Notes)

• Keysight D9010CAUC CAUI-4 Test Application software

Licensing information

Refer to the Data Sheet pertaining to D9010CAUC CAUI-4 Test Application to know about the 
licenses you must install along with other optional licenses. Visit 
“http://www.keysight.com/find/D9010CAUC” and in the web page's Document Library tab, you may 
view the associated Data Sheet.

To procure a license, you require the Host ID information that is displayed in the Keysight License 
Manager application installed on the same machine where you wish to install the license. 

The licensing format for Keysight License Manager 6 differs from its predecessors. See “Installing the 
License Key" on page 13 to see the difference in installing a license key using either of the 
applications on your machine.

http://www.keysight.com/
http://www.keysight.com/find/D9010CAUC
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Installing the Test Application 12
Installing the License Key 13

If you purchased the D9010CAUC CAUI-4 Test Application separate from your Infiniium oscilloscope, 
you must install the software and license key.



2 Installing the Test Application and Licenses

12 Keysight D9010CAUC CAUI-4 Test Application Methods of Implementation

Installing the Test Application

1 Make sure you have the minimum version of Infiniium Oscilloscope software (see the D9010CAUC 
release notes). To ensure that you have the minimum version, select Help > About Infiniium... from 
the main menu.

2 To obtain the CAUI-4 Test Application, go to Keysight website: 
“http://www.keysight.com/find/D9010CAUC”.

3 In the web page's Trials & Licenses tab, click the Details and Download button to view instructions 
for downloading and installing the application software.

http://www.keysight.com/find/D9010CAUC
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Installing the Test Application and Licenses 2

Installing the License Key

To procure a license, you require the Host ID information that is displayed in the Keysight License 
Manager application installed on the same machine where you wish to install the license.

Using Keysight License Manager 5

To view and copy the Host ID from Keysight License Manager 5:

1 Launch Keysight License Manager on your machine, where you wish to run the Test Application 
and its features.

2 Copy the Host ID that appears on the top pane of the application. Note that x indicates numeric 
values.

Figure 1 Viewing the Host ID information in Keysight License Manager 5

To install one of the procured licenses using Keysight License Manager 5 application,

1 Save the license files on the machine, where you wish to run the Test Application and its features.

2 Launch Keysight License Manager.

3 From the configuration menu, use one of the options to install each license file.

Figure 2 Configuration menu options to install licenses on Keysight License Manager 5

For more information regarding installation of procured licenses on Keysight License Manager 5, 
refer to Keysight License Manager 5 Supporting Documentation.

https://www.keysight.com/main/redirector.jspx?action=ref&nid=-33002.0.00&lc=eng&cc=IN&ckey=2953922&cname=EDITORIAL&nfr=-33002.0.02
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Using Keysight License Manager 6

To view and copy the Host ID from Keysight License Manager 6:

1 Launch Keysight License Manager 6 on your machine, where you wish to run the Test Application 
and its features.

2 Copy the Host ID, which is the first set of alphanumeric value (as highlighted in Figure 3) that 
appears in the Environment tab of the application. Note that x indicates numeric values.

Figure 3 Viewing the Host ID information in Keysight License Manager 6
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Installing the Test Application and Licenses 2

To install one of the procured licenses using Keysight License Manager 6 application,

1 Save the license files on the machine, where you wish to run the Test Application and its features.

2 Launch Keysight License Manager 6.

3 From the Home tab, use one of the options to install each license file.

Figure 4 Home menu options to install licenses on Keysight License Manager 6

For more information regarding installation of procured licenses on Keysight License Manager 6, 
refer to Keysight License Manager 6 Supporting Documentation.

https://www.keysight.com/main/redirector.jspx?action=obs&nid=-33002.0.00&lc=eng&cc=IN&ckey=2994142&pubno=&ltype=LitStation&ctype=EDITORIAL&nfr=-33002.0.02
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Before running the automated tests, you should calibrate the oscilloscope and probe. No test fixture 
is required for this application. After the oscilloscope and probe have been calibrated, you are ready 
to start the CAUI-4 Test Application and perform the measurements.
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Calibrating the Oscilloscope

If you have not already calibrated the oscilloscope, refer to the User Guide for the respective 
Oscilloscope you are using.

NOTE If the ambient temperature changes more than 5 degrees Celsius from the 
calibration temperature, internal calibration should be performed again. The 
delta between the calibration temperature and the present operating 
temperature is shown in the Utilities > Calibration menu.

NOTE If you switch cables between channels or other Oscilloscopes, it is necessary to 
perform cable and probe calibration again. Keysight recommends that, once 
calibration is performed, you label the cables with the channel on which they 
were calibrated.
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Starting the CAUI-4 Test Application

1 Ensure that the CAUI-4 Device Under Test (DUT) is operating and set to desired test modes.

2 To start the CAUI-4 Test Application: From the Infiniium Oscilloscope's main menu, select Analyze 
> Automated Test Apps > D9010CAUC CAUI-4 Test App.

• Figure 5 shows the Keysight D9010CAUC CAUI-4 Test Application window as it appears when 
launched within the Infiniium application of the DSO Q-Series Oscilloscope. The Instrument Setup 
area in the Set Up tab displays Real Edge, which indicates Channels 1R and 3R on the 
oscilloscope.

Figure 5 CAUI-4 Test Application main window on a Z-Series DSO
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• Figure 6 shows the Keysight D9010CAUC CAUI-4 Test Application window as it appears when 
launched within the Infiniium application of the UXR Oscilloscope. The Instrument Setup area in 
the Set Up tab displays the corresponding Channel assignments.

Figure 6 CAUI-4 Test Application main window on a UXR Oscilloscope
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The task flow pane and the tabs in the main pane show the steps you take in running the automated 
tests:

Set Up Lets you identify and set up the test environment, including information about the device under 
test.

Select the Multi-Lane Option to choose to test either with a single lane or with the switch matrix.
For UXR scopes, select the appropriate Channel option in Instrument Setup.
Click Switch Matrix Setup and configure the switch matrix feature, if you select Switch Matrix 
under Multi-Lane Option.
Set up InfiniiSim with the InfiniiSim Setup button.
With the Set Channel Skew button, the channels can be visually adjusted and skewed.
The Saved Waveform Setup button enables easy setup of saved waveforms. When waveforms are 
set up, the application makes all measurements on the saved waveforms.
The Select Lane Number enables you to choose to test a single lane or with the switch matrix.
The Device Identifier, User Description, and Comments are all printed in the final HTML report.
Click Connect PNA or Connect ENA to make the respective instrument's connection.

Select Tests Lets you select the tests you want to run. The tests are organized hierarchically so you can select all 
tests in a group. After tests are run, status indicators show which tests have passed, failed, or not 
been run, and there are indicators for the test groups.

Configure Lets you configure test parameters (for example, channels used in test, voltage levels, etc.).

Connect Shows you how to connect the oscilloscope to the device under test for the tests that are to be run.

Run Starts the automated tests. If the connections to the device under test need to be changed while 
multiple tests are running, the tests pause, show you how to change the connection, and wait for 
you to confirm that the connections have been changed before continuing.

Automate Lets you construct scripts of commands that drive execution of the application.

Results Contains more detailed information about the tests that have been run. You can change the 
thresholds at which marginal or critical warnings appear.

HTML Report Shows a compliance test report that can be printed.

NOTE In the Configure tab, the values for all such Configuration parameters that are 
Oscilloscope-dependent, will correspond to the Oscilloscope Model (DSOs or UXRs), where 
you are running the Test Application.
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Configuring CAUI-4 Test Application for test runs

To run one or more compliance tests on the DUT, which is connected to Oscilloscope, proceed to 
configure the CAUI-4 Test Application:

1 In the Set Up tab (shown in Figure 5 and Figure 6), select a Multi-Lane Option to determine the lane 
where the tests must be performed for the CAUI-4 standard.

If Switch Matrix is selected in the Multi-Lane Option, click Switch Matrix Setup to configure the 
Switch Matrix in the Test App. Refer to “Configuring Switch Matrix" on page 26 for more details.

2 In the Select Tests tab, select one or more tests.

3 In the Configure tab, you may change the values assigned to one or more options to cater to the 
compliance requirements for the selected tests. By default, the CAUI-4 Test Application sets 
optimum values for each configuration parameter.

Figure 7 Configure tab in the CAUI-4 Test Application

4 In the Connect tab, view the instructions along with the connection digram to ensure that all 
requirements for the physical setup of the testing instruments and the DUT are met. Click 
Connection Completed to indicate to the Test Application that the required hardware setup is 
complete. The connection diagram for most of the tests matches the one shown in Figure 5 for 
DSO-Q Series Oscilloscopes and Figure 6 for UXR Series Oscilloscopes. However, it is a good 
practice to verify the connection diagram and instructions displayed under this tab. The Test 
Application automatically indicates any changes in connections, if needed, during test runs.

5 Click Run Tests under this tab if you wish to start running tests. However, if you wish to modify the 
run settings before performing test runs, switch to the Run tab.
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Figure 8 Connect tab in CAUI-4 Test Application on a Z-series DSO
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Figure 9 Connect tab in CAUI-4 Test Application on a UXR scope
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Preparing to Take Measurements 3

6 In the Run tab, you may optionally modify one or more settings as described below, else click Run 
to start the test runs:

• determine the number of times each test must be run,

• automate specific actions in case of events, 

• store results for certain type of test trials only,

• send email notifications if the test runs pause or stop during runs.

Figure 10 Run tab in CAUI-4 Test Application

7 In the Automate tab, you may optionally configure automation scripts to perform specific 
actions/sequences within the Test Application.

8 In the Results tab, which appears automatically after test runs are complete, view the test results 
displayed for each selected test.

9 In the HTML Report tab, view a comprehensive report for each test within the Application. The Test 
Application enables exporting these results in CSV or HTML format for the purpose of analysis.

To perform a high-level analysis on each measurement data, you may upload the results to the 
KS6800A Series Analytics Services Software. Refer to “Uploading Results to Repository" on page 80 
to understand an overview on the functionality of this feature.
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Configuring Switch Matrix

Overview

Devices, with CAUI-4 standard, can run with the switch matrix using four dual single-ended 
connections or without the switch matrix using four differential probe connections. Both options are 
fully automated to switch across the four lanes. Switch Matrix requires either the Keysight U3020A 
S26 or the BitifEye BIT2100.

This chapter describes the switch matrix feature and steps for configuring the switch matrix in the 
Keysight D9010CAUC CAUI-4 Test Application.

An Oscilloscope has only four Channels to run tests. The limited number of channels may, at times, 
limit the testing of some multi-lane standards. Also, it may prove to be a hindrance to run test 
procedures for multi-port devices or simultaneous testing of multiple devices. The Switch Matrix 
feature on the Infiniium Oscilloscope overcomes such limitations.

The purpose of the ‘Switch Matrix’ feature is to ease the testing procedure, make it more feasible and 
to reduce the overall time. Using this feature, you can connect multiple lanes of the source devices to 
the correct switches and to obtain an accurate signal path whenever required.

Keysight recommends the following switches to be used with the Test Application:

• Keysight U3020A S26

• BitifEye BIT-2100

The following figure shows the connection setup for CAUI-4 tests with the switch matrix.

Enabling Switch Matrix

Before you begin the testing of multiple lane pairs of the source devices simultaneously, you must 
enable the Switch Matrix feature.

To enable the switch matrix feature:

1 Click Tools>Switch Matrix....

2 In the Configure Switch Matrix Settings dialog box, click On to enable the Switch Matrix feature.
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Enabling the Switch Matrix feature also enables the automated switch control. The option 
Automatically select drivers and paths (limited models) in the Configuration Mode section of the Controller 
tab is selected by default.

Establishing Connection to the Switch Drivers

Establishing connection to the Switch Drivers — Automatically

In the Configure Switch Matrix Settings dialog, under the Controller tab:

1 From the Switch Drivers section, select the switch model from the Model: drop-down options.

NOTE The switch settings and the response correction for all paths are reset if you 
toggle between switch models.
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2 Click the Connect button to be able to connect the selected switch driver to a physical switch 
instrument.

3 A Connect to <switch-model> dialog appears, which gives you two options to establish a 
connection to the selected switch models.

4 Select one of the options to establish connection:

Selecting Enter/Select VISA address/alias
1 Select Enter/Select VISA address/alias to type the complete SICL or VISA address of the switch 

driver. By default, this option is selected.

2 Click the Get button to identify the instrument at the specified address or alias and to view the 
current status of the instrument that is connected to the switch driver.

3 Click OK to return to the Configure Switch Matrix Settings dialog. The connection to the selected 
switch is displayed.
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4 Click OK to save the settings and return to the test environment.

Selecting from Keysight Connection Expert favorites
1 Choose Select from Keysight Connection Expert favorites to control the application with the help of 

remote PC. Upon selecting this option, the application starts seeking device information from the 
Keysight Connection Expert.

If remote access of the device is enabled, the Connect to <switch-model> dialog displays the list 
of active instruments.
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2 Click to select the Identify / Hide unresponsive addresses check box to run an IDN query to every 
instrument in the list and search for the active instruments, if any.

3 If any active instruments are found, the Connect to <switch-model> dialog lists out such 
instruments. Select the required instrument from the list.

4 Click OK to return to the Configure Switch Matrix Settings dialog. The connection to the selected 
switch is displayed.

5 Click OK in the Configure Switch Matrix Settings dialog to save the settings and return to the test 
environment.
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Establishing connection to the Switch Drivers — Manually

The Manually perform these tasks (any supported model) option allows you to decide how many drivers to 
use and how to route the signal paths. It enables the use of any supported switch model.

In the Configure Switch Matrix Settings dialog:

1 Click to select the Manually perform these tasks (any supported model) radio button in the Configuration 
Mode section.

2 From the Switch Drivers section, select the switch model from the Model: drop-down options.

NOTE The Select from Keysight Connection Expert favorites option is available 
only when the device is powered on and enabled for remote access. 
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3 In the Switch Drivers section, you may use the Add button to append the list of any additional 
drivers, which require a connection to an instrument. Use the Delete button to remove a selected 
driver from the list. Removing the driver from the list dissociates any signal paths that may have 
been assigned to it earlier.
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4 When you click the Add... button, the Connect... button appears so that you can establish 
connectivity to the selected Switch. 

5 The rest of the steps for establishing a connection to the switch model remains the same as 
described in the previous section. The only difference between automatic and manual modes is 
that you can add/delete and select switch drivers (any supported model) as per your 
requirements and preferences in the manual mode.

Configuring Signal Paths

Once you have enabled the Switch Matrix feature and set up connections to the switch drivers, you 
must configure signal paths. The options to configure the signal paths vary depending upon whether 
you have selected Automatically select drivers and paths (limited models) or Manually perform these tasks 
(any supported model) in the Controller tab of the Configure Switch Matrix Settings dialog.

Refer to the connection diagram before configuring signal paths either for Automatic or Manual 
selection. Under the Controller tab, click the Connection Guide button to access the Connection 
Diagram dialog.
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Configuring Signal Paths with Automatic Selection

When you have selected Automatically select drivers and paths (limited models) in the Controller tab of the 
Configure Switch Matrix Settings dialog:

1 Click the Signal Paths tab. The Path Assignment table lists the connection matrix of the device with 
the Switch modules.

2 Scroll down to view the automatic connections that have been established.

At runtime, when the Switch Matrix module is on and when a connection prompt occurs, two events 
occur:

• The framework suppresses the prompts.

• The Switch Matrix module detects the new connection and then throw switches, as indicated in 
the Switch column, taking into account the current value of the configuration variable (if any) 
associated with the connection.

Configuring Signal Paths with Manual Selection

When you have selected Manually perform these tasks (any supported model) in the Controller tab of the 
Configure Switch Matrix Settings dialog:

1 Click the Signal Paths tab in the Configure Switch Matrix Settings dialog.

2 Select the channel or switch module in one of the drop-down options. Manually select the 
alternative channel or driver module from the other drop-down option.

3 Optionally, you may change the lane assignments and the corresponding Switch modules.

4 Click the View Connections... button to view the signal path mapping, to understand how the 
signal path maps to the connection diagrams being used by the application.

5 The Signal Paths Connection View dialog is displayed. Select any one of the available options in the 
Connection: drop-down.

6 The Path Assignment & Response Correction area displays the connections configured for the 
corresponding connection diagrams in the Connection: drop-down.

7 Select an entry in the Path Assignment & Response Correction area to view the corresponding test 
information.

8 Click the Tests... button to view information about the tests that use the selected connection to 
perform automated tests.

9 Click the Close button to exit and return to the Configure Switch Matrix Settings dialog to finish the 
signal path configuration.

10 If required, use the Reset Paths... button to clear all switch and response correction settings for all 
paths. Click OK if you wish to proceed.

11 Also, if needed, use the Load Preconfigured Settings... button to set switches for all paths as per the 
recommended settings. Click OK if you wish to proceed.
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Response Correction

You must specify the response correction after you finish configuring the signal paths. Configuring 
this area is vital as it impacts the measurement accuracy, credibility and performance of the 
Oscilloscope. The purpose of response correction is to correct the channel frequency response of the 
oscilloscope.

For each scope channel that you select, the default response correction method is None, which turns 
off normalization for the specified path. 

You may use the Edit Settings button or double-click the selected row to access the corresponding 
configuration dialog, if you wish to make further changes to a specific scope channel configuration.

Use the Execute Switches button to establish a connection between the selected test point and scope 
channel. The color of this button corresponds to the Oscilloscope Channel where the Switch is 
connected to.

In the following example, the application displays the prompt indicating that a connection is 
established when you click Execute Switches after selecting the first row. Click OK to close the prompt.
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Once you have finished response corrections for all connections, click OK in the Configure Switch Matrix 
Settings dialog. The application redirects you to the test environment.
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NOTE Use a test system that consists of a fourth-order Bessel-Thomson low-pass 
response with 33 GHz 3 dB bandwidth for all output signal measurements, 
unless stated otherwise.
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Main Voltage Measurements (pattern: PRBS9)

This section provides the Methods of Implementation (MOIs) for the CAUI-4 Main Voltage 
Measurements using a Keysight Infiniium oscilloscope and the CAUI-4 Test Application.

Figure 11 Tests that appear under Main Voltage Measurements 

Limits for Main
Voltage

Measurements

The limits for tests under main voltage measurements can be found in section 93.8.1.3 of IEEE 802.3 
specifications. Refer to Table 83D-1 for corresponding values.

• Differential Peak to Peak Output Voltage Test with TX disabled (max 30 mV)

• DC Common Mode Output Voltage Test (0 to 1.9 V)

• AC Common Mode Output Voltage Test (max 12 mV)

• Differential Peak to Peak Output Voltage Test (max 1200 mV)

NOTE A test system with a fourth-order Bessel-Thomson low-pass response with 
33 GHz 3 dB bandwidth is to be used for all transmitter signal 
measurements, unless otherwise specified.
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Differential Peak to Peak Output Voltage Test with TX Disabled

Test Overview The purpose of this test is to verify that when TX is disabled the peak-to-peak voltage is less than 
30 mV.

PASS Condition Refer to Limits for Main Voltage Measurements.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Check that the signal is truly with TX disabled (no valid data transitions).

3 Measure peak-to-peak voltage of the signal.

4 Compare the max peak-to-peak voltage to 30 mV.

DC Common Mode Output Voltage Test

Test Overview The purpose of this test is to verify that the common mode signal of the differential pair is between 
0-1.9 V.

PASS Condition Refer to Limits for Main Voltage Measurements.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Verify that there is a signal and that the connection is dual-single ended.

3 Measure the peak-to-peak voltage. 

• If the Test Application is running on the DSO Oscilloscope, the Instrument Setup is preset to Real 
Edge.

• If the Test Application is running on the UXR Oscilloscope, perform the measurement with the 
Instrument Setup set to Channels 1 and 2. Repeat the measurement with the Instrument Setup set to 
Channels 3 and 4.

4 Compare the voltage measurement to 0-1.9 V.

AC Common Mode Output Voltage Test

Test Overview The purpose of this test is to verify that the common mode signal of the differential pair rms voltage 
does not exceed 12 mV.

PASS Condition Refer to Limits for Main Voltage Measurements.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Verify that there is a signal and that the connection is dual-single ended.

3 Measure the peak-to-peak voltage. 

• If the Test Application is running on the DSO-Z Series Oscilloscope, the Instrument Setup is preset 
to Real Edge.

• If the Test Application is running on the UXR Series Oscilloscope, perform the measurement with 
the Instrument Setup set to Channels 1 and 2. Repeat the measurement with the Instrument Setup set 
to Channels 3 and 4.

NOTE This measurement can be done only with dual-single ended connection; it cannot be done with a 
differential probing connection.

NOTE This measurement can be done only with dual-single ended connection; it cannot be done with a 
differential probing connection.
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4 Compare the voltage measurement to 12 mV.

Differential Peak to Peak Output Voltage Test

Test Overview The purpose of this test is to verify that the peak-to-peak voltage of the differential signal on a 
PRBS9 pattern is less than 1200 mV.

PASS Condition Refer to Limits for Main Voltage Measurements.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Verify that there is a signal is connected and has a PRBS9 pattern.

3 Measure the peak-to-peak voltage of the differential signal of DUT+ and DUT-.

4 Compare the max peak-to-peak voltage to 1200 mV.
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Jitter and Signaling Rate Measurements (pattern: PRBS9)

This section provides the Methods of Implementation (MOIs) for the Jitter and Signaling Rate 
Measurements using a Keysight Infiniium oscilloscope and the CAUI-4 Test Application.

Figure 12 Tests that appear under Jitter and Signaling Rate Measurements

Limits for Jitter and
Signaling Rate
Measurements

The limits for tests under jitter and signaling rate measurements can be found in various sections of 
IEEE 802.3 specification. Refer to Table 83D-1 for corresponding values.

• Signaling Rate (25.78125 ±100 ppm GBd) (section 93.8.1.2)

• Even-Odd Jitter (max 35 mUI) (section 92.8.3.8)

• Bounded Uncorrelated Jitter (max 100 mUI)a (section 92.8.3.8)

• Total Uncorrelated Jitter (max 260 mUI)a,b (section 92.8.3.8)

a Effective bounded uncorrelated jitter and effective total uncorrelated jitter are measured as defined in 92.8.3.9.2 except that the range 
for fitting CDFLi and CDFRi, as defined in (92.8.3.8.2 c), shall be from 10-6 to 10-4.

b Effective total uncorrelated jitter, peak-to-peak is specified to a 10-15 probability.
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Signaling Rate

Test Overview The purpose of this test is to verify that the signaling rate mean is between 25.78125 ±100 ppm GBd.

PASS Condition Refer to Limits for Jitter and Signaling Rate Measurements.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Check that signal is connected and data pattern exists (PRBS9 must be used for this test).

3 Set memory depth to capture the number or UI set in the configuration tab.

4 Set data rate measurement to semi-automatic 25.78125 Gb/s.

5 Measure min, max, mean signaling rate.

6 Report min and max values.

7 Compare and report the mean signaling rate value to 25.78125 ±100 ppm GBd.

Jitter (Even-Odd Jitter, Bounded Uncorrelated Jitter, Total Uncorrelated Jitter)

Test Overview The purpose of this test is to verify that differential signal's Even-Odd Jitter is less that 35 mUI, 
Bounded Uncorrelated Jitter is less than 100 mUI, and Total Uncorrelated Jitter is less than 260 mUI. 
If all tests are selected, all tests are run on a single measurement. Each test can be run individually 
by selecting any or some of the tests.

PASS Conditions • Refer to Limits for Jitter and Signaling Rate Measurements.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Check that signal is connected and data pattern exists (PRBS9 must be used for this test).

3 Set memory depth to capture the number or UI set in the configuration tab.

4 Set clock recovery to OJTF First Order PLL with Nominal Data Rate 25.78125 Gb/s and Loop 
Bandwidth to 10 MHz.

5 Using EZJIT, measure Even-Odd Jitter, BUJ, and TUJ at BER of 10E-12.

6 Compare and report the values to their respective maximum specification.
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Output Waveform Measurements (pattern: PRBS9)

This section provides the Methods of Implementation (MOIs) for the Output Waveform Measurements 
using a Keysight Infiniium oscilloscope and the CAUI-4 Test Application.

Figure 13 Selecting Transmitter Output Waveform Measurement Tests

Limits for Output
Waveform

Measurements

The limits for some tests under output waveform measurements can be found in various sections of 
IEEE 802.3 specification. Refer to Table 83D-1 for corresponding values.

• Steady-State Voltage Vf (400 to 600 mV) (section 93.8.1.5.2)*

• Linear Fit Pulse Peak (0.71 x Vf) (section 93.8.1.5.2)*

• Signal-to-noise-and-distortion ratio (27 dB) (section 93.8.1.6)*

* The values of the parameters are measured as defined in the referenced subclause except that the values of Np and Nw are 5.
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Steady State Voltage Vf

Test Overview The purpose of this test is to verify that the Steady State Voltage is between 0.4V and 0.6V.

Pass Condition Refer to Limits for Output Waveform Measurements.

Measurement
Algorithm

1 Check that signal is connected and proper data pattern exists (PRBS9 must be used for this test).

2 Set memory depth and sample rate to capture the 511 bits of the PRBS9 pattern.

3 Calculate Vf using the equations in section 85.8.3.3. The resulting value is the sum of columns of 
p(k)/M. Np = 5, Dp = 2.

4 Compare and report the resulting value in the range between 0.4V and 0.6V.

Linear Fit Pulse Peak

Test Overview The purpose of this test is to verify that the Linear Fit Pulse meets the specified standards.

Pass Conditions Refer to Limits for Output Waveform Measurements.

Measurement
Algorithm

1 Check that signal is connected and proper data pattern exists (PRBS9 must be used for this test).

2 Set memory depth and sample rate to capture the 511 bits of the PRBS9 pattern.

3 Calculate Linear Fit Pulse using the equations in section 85.8.3.3.5. The resulting value is the 
peak value of p(k). Np = 5, Dp = 2.

4 Compare the specified standards to the resulting value.

Signal-to-noise-and-distortion ratio

Test Overview The purpose of this test is to verify that the Signal-to-noise-and-distortion ratio (SNDR) meets the 
specified standards.

Pass Condition Refer to Limits for Output Waveform Measurements.

Measurement
Algorithm

1 Calculate SNDR using measurements from Level RMS - PRBS pattern test and error from Linear 
Fit Pulse Peak test.

2 Compare the resulting value of SNDR to the specified standards.

NOTE Run the Steady-State Voltage Vf test as a prerequisite to running the Linear 
Fit Pulse Peak test.
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Pre and Post Equalization Tests

Figure 14 Selecting Pre and Post Equalization Tests

Test Overview The purpose of this test is to verify the Pre-cursor and Post-cursor equalization ratios.

Pass Condition Refer to the respective sections described below.

Measurement
Algorithm

To know about the measurement algorithm for each Pre and Post Equalization Tests, see:

• “Pre-cursor equalization Local_eq_cm1(0)” on page 46

• “Pre-cursor equalization Local_eq_cm1(1)” on page 46

• “Pre-cursor equalization Local_eq_cm1(2)” on page 47

• “Pre-cursor equalization Local_eq_cm1(3)” on page 47

• “Post-cursor equalization Local_eq_c1(0)” on page 48

• “Post-cursor equalization Local_eq_c1(1)” on page 48

• “Post-cursor equalization Local_eq_c1(2)” on page 49

• “Post-cursor equalization Local_eq_c1(3)” on page 49

• “Post-cursor equalization Local_eq_c1(4)” on page 50

• “Post-cursor equalization Local_eq_c1(5)” on page 50
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Pre-cursor equalization Local_eq_cm1(0)

Test Overview The purpose of this test is to verify that the Pre-cursor equalization ratio is 0 ± 0.04.

Pass Condition When the Pre-cursor equalization with weight Local_eq_cm1 = 0, the ratio defined by C(-1) / [|C(-1)| 
+ |C(0)| + |C(1)|] must be within 0 ± 0.04. Refer to Table 83D-2 in section 83D.3.1.1 in the IEEE802.3 
specification.

Measurement
Algorithm

1 Request Transmitter to be set to “PRESET” condition.

2 Set memory depth to capture one full PRBS9 pattern and scale.

3 Calculate linear fit pulse response at “PRESET” condition.

4 Define matrix Rm using equation (92-4) from IEEE 802.3.

5 Request to change the eq setting to Pre-cursor equalization with weight local_eq_cm1 = 0.

6 Calculate linear fit pulse response.

7 Calculate coefficients using equation (92-5) from IEEE 802.3.

8 Calculate pre-cursor ratio using the equation C(-1) / [|C(-1)| + |C(0)| + |C(1)|].

9 Compare and report the value of pre-cursor ratio with 0 ± 0.04.

Pre-cursor equalization Local_eq_cm1(1)

Test Overview The purpose of this test is to verify that the Pre-cursor equalization ratio is -0.05 ± 0.04.

Pass Condition When the Pre-cursor equalization with weight Local_eq_cm1 = 1, the ratio defined by C(-1) / [|C(-1)| 
+ |C(0)| + |C(1)|] must be within -0.05 ± 0.04. Refer to Table 83D-2 in section 83D.3.1.1 in the 
IEEE802.3 specification.

Measurement
Algorithm

Skip to step 5 if the first four steps have already been measured/calculated in a previous equalization 
test of the same trial.

1 Request Transmitter to be set to “PRESET” condition.

2 Set memory depth to capture one full PRBS9 pattern and scale.

3 Calculate linear fit pulse response at “PRESET” condition.

4 Define matrix Rm using equation (92-4) from IEEE 802.3.

5 Request to change the eq setting to Pre-cursor equalization with weight local_eq_cm1 = 1.

6 Calculate linear fit pulse response.

7 Calculate coefficients using equation (92-5) from IEEE 802.3.

8 Calculate pre-cursor ratio using the equation C(-1) / [|C(-1)| + |C(0)| + |C(1)|].

9 Compare and report the value of pre-cursor ratio with -0.05 ± 0.04.
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Pre-cursor equalization Local_eq_cm1(2)

Test Overview The purpose of this test is to verify that the Pre-cursor equalization ratio is -0.1 ± 0.04.

Pass Condition When the Pre-cursor equalization with weight Local_eq_cm1 = 2, the ratio defined by C(-1) / [|C(-1)| 
+ |C(0)| + |C(1)|] must be within -0.1 ± 0.04. Refer to Table 83D-2 in section 83D.3.1.1 in the 
IEEE802.3 specification.

Measurement
Algorithm

Skip to step 5 if the first four steps have already been measured/calculated in a previous equalization 
test of the same trial.

1 Request Transmitter to be set to “PRESET” condition.

2 Set memory depth to capture one full PRBS9 pattern and scale.

3 Calculate linear fit pulse response at “PRESET” condition.

4 Define matrix Rm using equation (92-4) from IEEE 802.3.

5 Request to change the eq setting to Pre-cursor equalization with weight local_eq_cm1 = 2.

6 Calculate linear fit pulse response.

7 Calculate coefficients using equation (92-5) from IEEE 802.3.

8 Calculate pre-cursor ratio using the equation C(-1) / [|C(-1)| + |C(0)| + |C(1)|].

9 Compare and report the value of pre-cursor ratio with -0.1 ± 0.04.

Pre-cursor equalization Local_eq_cm1(3)

Test Overview The purpose of this test is to verify that the Pre-cursor equalization ratio is -0.15 ± 0.04.

Pass Condition When the Pre-cursor equalization with weight Local_eq_cm1 = 3, the ratio defined by C(-1) / [|C(-1)| 
+ |C(0)| + |C(1)|] must be within -0.15 ± 0.04. Refer to Table 83D-2 in section 83D.3.1.1 in the 
IEEE802.3 specification.

Measurement
Algorithm

Skip to step 5 if the first four steps have already been measured/calculated in a previous equalization 
test of the same trial.

1 Request Transmitter to be set to “PRESET” condition.

2 Set memory depth to capture one full PRBS9 pattern and scale.

3 Calculate linear fit pulse response at “PRESET” condition.

4 Define matrix Rm using equation (92-4) from IEEE 802.3.

5 Request to change the eq setting to Pre-cursor equalization with weight local_eq_cm1 = 3.

6 Calculate linear fit pulse response.

7 Calculate coefficients using equation (92-5) from IEEE 802.3.

8 Calculate pre-cursor ratio using the equation C(-1) / [|C(-1)| + |C(0)| + |C(1)|].

9 Compare and report the value of pre-cursor ratio with -0.15 ± 0.04.
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Post-cursor equalization Local_eq_c1(0)

Test Overview The purpose of this test is to verify that the Post-cursor equalization ratio is 0 ± 0.04.

Pass Condition When the Post-cursor equalization with weight Local_eq_c1 = 0, the ratio defined by C(1) / [|C(-1)| + 
|C(0)| + |C(1)|] must be within 0 ± 0.04. Refer to Table 83D-3 in section 83D.3.1.1 in the IEEE802.3 
specification.

Measurement
Algorithm

Skip to step 5 if the first four steps have already been measured/calculated in a previous equalization 
test of the same trial.

1 Request Transmitter to be set to “PRESET” condition.

2 Set memory depth to capture one full PRBS9 pattern and scale.

3 Calculate linear fit pulse response at “PRESET” condition.

4 Define matrix Rm using equation (92-4) from IEEE 802.3.

5 Request to change the eq setting to Post-cursor equalization with weight local_eq_c1 = 0.

6 Calculate linear fit pulse response.

7 Calculate coefficients using equation (92-5) from IEEE 802.3.

8 Calculate post-cursor ratio using the equation C(1) / [|C(-1)| + |C(0)| + |C(1)|].

9 Compare and report the value of post-cursor ratio with 0 ± 0.04.

Post-cursor equalization Local_eq_c1(1)

Test Overview The purpose of this test is to verify that the Post-cursor equalization ratio is -0.05 ± 0.04.

Pass Condition When the Post-cursor equalization with weight Local_eq_c1 = 1, the ratio defined by C(1) / [|C(-1)| + 
|C(0)| + |C(1)|] must be within -0.05 ± 0.04. Refer to Table 83D-3 in section 83D.3.1.1 in the IEEE802.3 
specification.

Measurement
Algorithm

Skip to step 5 if the first four steps have already been measured/calculated in a previous equalization 
test of the same trial.

1 Request Transmitter to be set to “PRESET” condition.

2 Set memory depth to capture one full PRBS9 pattern and scale.

3 Calculate linear fit pulse response at “PRESET” condition.

4 Define matrix Rm using equation (92-4) from IEEE 802.3.

5 Request to change the eq setting to Post-cursor equalization with weight local_eq_c1 = 1.

6 Calculate linear fit pulse response.

7 Calculate coefficients using equation (92-5) from IEEE 802.3.

8 Calculate post-cursor ratio using the equation C(1) / [|C(-1)| + |C(0)| + |C(1)|].

9 Compare and report the value of post-cursor ratio with -0.05 ± 0.04.
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Post-cursor equalization Local_eq_c1(2)

Test Overview The purpose of this test is to verify that the Post-cursor equalization ratio is -0.1 ± 0.04.

Pass Condition When the Post-cursor equalization with weight Local_eq_c1 = 2, the ratio defined by C(1) / [|C(-1)| + 
|C(0)| + |C(1)|] must be within -0.1 ± 0.04. Refer to Table 83D-3 in section 83D.3.1.1 in the IEEE802.3 
specification.

Measurement
Algorithm

Skip to step 5 if the first four steps have already been measured/calculated in a previous equalization 
test of the same trial.

1 Request Transmitter to be set to “PRESET” condition.

2 Set memory depth to capture one full PRBS9 pattern and scale.

3 Calculate linear fit pulse response at “PRESET” condition.

4 Define matrix Rm using equation (92-4) from IEEE 802.3.

5 Request to change the eq setting to Post-cursor equalization with weight local_eq_c1 = 2.

6 Calculate linear fit pulse response.

7 Calculate coefficients using equation (92-5) from IEEE 802.3.

8 Calculate post-cursor ratio using the equation C(1) / [|C(-1)| + |C(0)| + |C(1)|].

9 Compare and report the value of post-cursor ratio with -0.1 ± 0.04.

Post-cursor equalization Local_eq_c1(3)

Test Overview The purpose of this test is to verify that the Post-cursor equalization ratio is -0.15 ± 0.04.

Pass Condition When the Post-cursor equalization with weight Local_eq_c1 = 3, the ratio defined by C(1) / [|C(-1)| + 
|C(0)| + |C(1)|] must be within -0.15 ± 0.04. Refer to Table 83D-3 in section 83D.3.1.1 in the IEEE802.3 
specification.

Measurement
Algorithm

Skip to step 5 if the first four steps have already been measured/calculated in a previous equalization 
test of the same trial.

1 Request Transmitter to be set to “PRESET” condition.

2 Set memory depth to capture one full PRBS9 pattern and scale.

3 Calculate linear fit pulse response at “PRESET” condition.

4 Define matrix Rm using equation (92-4) from IEEE 802.3.

5 Request to change the eq setting to Post-cursor equalization with weight local_eq_c1 = 3.

6 Calculate linear fit pulse response.

7 Calculate coefficients using equation (92-5) from IEEE 802.3.

8 Calculate post-cursor ratio using the equation C(1) / [|C(-1)| + |C(0)| + |C(1)|].

9 Compare and report the value of post-cursor ratio with -0.15 ± 0.04.
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Post-cursor equalization Local_eq_c1(4)

Test Overview The purpose of this test is to verify that the Post-cursor equalization ratio is -0.2 ± 0.04.

Pass Condition When the Post-cursor equalization with weight Local_eq_c1 = 4, the ratio defined by C(1) / [|C(-1)| + 
|C(0)| + |C(1)|] must be within -0.2 ± 0.04. Refer to Table 83D-3 in section 83D.3.1.1 in the IEEE802.3 
specification.

Measurement
Algorithm

Skip to step 5 if the first four steps have already been measured/calculated in a previous equalization 
test of the same trial.

1 Request Transmitter to be set to “PRESET” condition.

2 Set memory depth to capture one full PRBS9 pattern and scale.

3 Calculate linear fit pulse response at “PRESET” condition.

4 Define matrix Rm using equation (92-4) from IEEE 802.3.

5 Request to change the eq setting to Post-cursor equalization with weight local_eq_c1 = 4.

6 Calculate linear fit pulse response.

7 Calculate coefficients using equation (92-5) from IEEE 802.3.

8 Calculate post-cursor ratio using the equation C(1) / [|C(-1)| + |C(0)| + |C(1)|].

9 Compare and report the value of post-cursor ratio with -0.2 ± 0.04.

Post-cursor equalization Local_eq_c1(5)

Test Overview The purpose of this test is to verify that the Post-cursor equalization ratio is -0.25 ± 0.04.

Pass Condition When the Post-cursor equalization with weight Local_eq_c1 = 5, the ratio defined by C(1) / [|C(-1)| + 
|C(0)| + |C(1)|] must be within -0.25 ± 0.04. Refer to Table 83D-3 in section 83D.3.1.1 in the IEEE802.3 
specification.

Measurement
Algorithm

Skip to step 5 if the first four steps have already been measured/calculated in a previous equalization 
test of the same trial.

1 Request Transmitter to be set to “PRESET” condition.

2 Set memory depth to capture one full PRBS9 pattern and scale.

3 Calculate linear fit pulse response at “PRESET” condition.

4 Define matrix Rm using equation (92-4) from IEEE 802.3.

5 Request to change the eq setting to Post-cursor equalization with weight local_eq_c1 = 5.

6 Calculate linear fit pulse response.

7 Calculate coefficients using equation (92-5) from IEEE 802.3.

8 Calculate post-cursor ratio using the equation C(1) / [|C(-1)| + |C(0)| + |C(1)|].

9 Compare and report the value of post-cursor ratio with -0.25 ± 0.04.
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Return Loss PNA/ENA Measurements

This section provides the Methods of Implementation (MOIs) for the Return Loss Measurements 
using a Keysight Infiniium oscilloscope, PNA or ENA, and the CAUI-4 Test Application. The test 
application controls the PNA/ENA to set the test limits and run the test. You must ensure that the 
calibration must be done on the PNA/ENA.

Figure 15 Tests that appear under Return loss PNA/ENA Measurements

Limits for Return Loss
PNA/ENA

measurements

The limits for tests under return loss PNA/ENA measurements can be found in section 93.8.1.4 of 
IEEE 802.3 specification. Refer to Table 83D-1 for corresponding values.

• Differential Output Return Loss (see Eq. 93-3)

• Common-mode Output Return Loss (see Eq. 93-4)

Measurement
Algorithm (common

for both tests)

1 Ensure that the PNA/ENA is physically connected and calibrated.

2 In the Set Up tab of the Test Application, click Connect PNA or Connect ENA to establish connectivity 
to the connected equipment.

3 Click the Select Tests tab and check the tests to measure the Return Loss Measurements.

4 Click Run under the Run tab. The Test Application automatically calculates the return loss.

5 Compare the reported values with the specification to check for compliance.
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NOTE Use a test system that consists of a fourth-order Bessel-Thomson low-pass 
response with 33 GHz 3 dB bandwidth for all output signal measurements, 
unless stated otherwise.
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Main Voltage Measurements (pattern: Square8 or PRBS9)

The Main Voltage measurement procedures described in this section are performed using a Keysight 
Infiniium oscilloscope and the CAUI-4 Test Application.

Figure 15 Selecting Main Voltage Measurement Tests

Limits for Main
Voltage

Measurements

The limits for tests under main voltage measurements can be found in section 83E.3.1.2 of IEEE 
802.3 specifications. Refer to Table 83E-1 for corresponding values.

• Differential Peak to Peak Output Voltage Test with TX disabled (max 35 mV)

• Differential Peak to Peak Output Voltage Test (max 900 mV)

• AC Common Mode Output Voltage Test (max 17.5 mV)

• DC Common Mode Output Voltage Test (-0.3 to 2.8 V)

• Single-Ended Output Voltage Test (-0.4 to 3.3 V)



Keysight D9010CAUC CAUI-4 Test Application Methods of Implementation 55

Host Output Characteristics at TP1a 5

Differential Peak to Peak Output Voltage Test with TX Disabled

Test Overview The purpose of this test is to verify that when TX is disabled, the peak-to-peak voltage must be less 
than 35mV.

Pass Condition Refer to Limits for Main Voltage Measurements.

Measurement
Algorithm

1 Obtain a sample or acquire the signal data.

2 Ensure that TX is disabled on the acquired signal (no valid data transitions).

3 Measure peak-to-peak voltage of the signal.

4 Compare the maximum peak-to-peak voltage to 35mV.

Differential Peak to Peak Output Voltage Test

Test Overview The purpose of this test is to verify that the peak-to-peak voltage of the differential signal on a 
Square8 or PRBS9 pattern is less than 900mV.

Pass Condition Refer to Limits for Main Voltage Measurements.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Verify that the signal is connected, has TX enabled and has either a Square8 or a PRBS9 pattern.

3 Measure the peak-to-peak voltage of the differential signal on DUT+ and DUT-.

4 Compare the maximum peak-to-peak voltage with 900mV.

AC Common Mode Output Voltage Test

Test Overview The purpose of this test is to verify that the common mode signal does not exceed 17.5mV.

Pass Condition Refer to Limits for Main Voltage Measurements.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Verify that there is a signal and that the connection is dual single-ended.

3 Measure the AC common-mode voltage.

• If the Test Application is running on the DSO Oscilloscope, the Instrument Setup is preset to Real 
Edge. 

• If the Test Application is running on the UXR Oscilloscope, perform the measurement with the 
Instrument Setup set to Channels 1 and 2. Repeat the measurement with the Instrument Setup set to 
Channels 3 and 4.

4 Compare the voltage measurement with 17.5mV.

NOTE This measurement can be done only with dual single-ended connection but not 
with a differential probing connection.
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DC Common Mode Output Voltage Test

Test Overview The purpose of this test is to verify that the common mode signal is between -300mV and 2.8V.

Pass Condition Refer to Limits for Main Voltage Measurements.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Measure the DC common-mode voltage.

• If the Test Application is running on the DSO Series Oscilloscope, the Instrument Setup is preset to 
Real Edge. 

• If the Test Application is running on the UXR Series Oscilloscope, perform the measurement with 
the Instrument Setup set to Channels 1 and 2. Repeat the measurement with the Instrument Setup set 
to Channels 3 and 4.

3 Compare the voltage measurement to the range between -300mV and 2.8V.

Single-ended Output Voltage Test

Test Overview The purpose of this test is to verify that the minimum voltage on a single-ended signal is greater than 
-400mV and that the maximum voltage is less than 3.3V.

Pass Condition Refer to Limits for Main Voltage Measurements.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Verify that there is a signal and that the connection is dual single-ended.

3 Measure the minimum and maximum voltage on each single-ended signal.

4 Compare the voltage measurements with the range between -400mV and 3.3V.

NOTE This measurement can be done only with dual-single ended connection but not 
with a differential probing connection.

NOTE This measurement can be done only with dual single-ended connection but not 
with a differential probing connection.
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Transition Time Measurements (pattern: Square8)

The Transition Time Measurement procedures described in this section are performed using a 
Keysight Infiniium oscilloscope and the CAUI-4 Test Application.

Figure 16 Selecting Transition Time Measurement Tests

Limits for Transition
Time Measurements

The limits for tests under main voltage measurements can be found in section 83E.3.1.5 of IEEE 
802.3 specifications. Refer to Table 83E-1 for corresponding values.

• Minimum Output Rise Time (20% - 80%) (10ps)

• Minimum Output Fall Time (20% - 80%) (10ps)
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Minimum Output Rise Time (20%-80%)

Test Overview The purpose of this test is to verify that the minimum rise time is 10 ps.

Pass Condition Refer to Limits for Transition Time Measurements.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Verify that the signal is Square8.

3 Measure rise time from 20% to 80% of the signal amplitude.

4 Compare the minimum rise time with 10ps.

Minimum Output Fall Time (20%-80%)

Test Overview The purpose of this test is to verify that the minimum fall time is 10ps.

Pass Condition Refer to Limits for Transition Time Measurements.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Verify that the signal is Square8.

3 Measure fall time from 20% to 80% of the signal amplitude.

4 Compare the minimum fall time with 10ps.
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Signaling Rate and Eye Mask Measurements TP1a

The Signaling Rate and Eye Mask Measurement procedures that are described in this section are 
performed using a Keysight Infiniium oscilloscope and the CAUI-4 Test Application.

Figure 17 Selecting Signaling Rate and Eye Mask Measurement Tests

Limits for Signaling
Rate and Eye Mask

Measurements

The limits for tests under main voltage measurements can be found in various sections of IEEE 802.3 
specifications. Refer to Table 83E-1 for corresponding values.

• Signaling Rate (25.78125 ±100 ppm GBd) (section 83E.3.1.1)

• Eye Height A (95 mV) (section 83E.3.1.6)

• Eye Width (0.46 UI) (section 83E.3.1.6)

• Eye Height B (80 mV) (section 83E.3.1.6)
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Signaling Rate

Test Overview The purpose of this test is to verify that the signaling rate mean is between 25.78125 ±100 ppm GBd.

Pass Condition Refer to Limits for Signaling Rate and Eye Mask Measurements.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Check that signal is connected and data pattern exists (PRBS9 must be used for this test).

3 Set memory depth to capture the number or UI set in the configuration tab.

4 Set data rate measurement to semi-automatic 25.78125 Gb/s.

5 Measure min, max, mean signaling rate.

6 Report min and max values.

7 Compare and report the mean signaling rate value to 25.78125 ±100 ppm GBd.

Eye Height A

Test Overview The purpose of this test is to verify that for a defined range of CTLE settings, the Eye Height A is 
greater than 95 mV. The CTLE values range from 1dB lower than the user-defined optimal CTLE to 
1dB higher than the user-defined optimal CTLE.

Pass Conditions Refer to Limits for Signaling Rate and Eye Mask Measurements.

Measurement
Algorithm

1 For the optimal CTLE, you may approach in one of the following ways:

• This setting can be characterized and automatically set by using the Find Optimal CTLE Eye 
Opening test under the Utilities in the Select Tests tab.

• Manually select the optimal CTLE setting from the Use Optimized CTLE for Eye Opening drop-down 
options in the Configure tab. The selected CTLE setting is called as ‘User-defined optimal CTLE’.

2 Select which CTLE setting to test in the Configure tab (Host Recommended CTLE, 1 dB lower than 
optimal CTLE, or 1 dB higher than optimal CTLE).

3 Obtain sample or acquire signal data.

4 Set memory depth to capture the number or UI set in the Configure tab.

5 Set selected CTLE setting as per table 83E-2.

6 Set Clock Recovery to First Order PLL with Loop Bandwidth = 10 MHz.

7 Measure the Eye Height A at an Eye Height/Width Probability setting of 1E-15.

8 Compare the Eye Height A with 95mV. Report the resulting value.

Eye Width

Test Overview The purpose of this test is to verify that for a defined range of CTLE settings, the Eye Width is greater 
than 460mUI. The CTLE values range from 1dB lower than the user-defined optimal CTLE to 1dB 
higher than the user-defined optimal CTLE.

Pass Conditions Refer to Limits for Signaling Rate and Eye Mask Measurements.

Measurement
Algorithm

1 For the optimal CTLE, you may approach in one of the following ways:

• This setting can be characterized and automatically set by using the Find Optimal CTLE Eye 
Opening test under the Utilities in the Select Tests tab.

• Manually select the optimal CTLE setting from the Use Optimized CTLE for Eye Opening drop-down 
options in the Configure tab. The selected CTLE setting is called as ‘User-defined optimal CTLE’.

2 Select which CTLE setting to test in the Configure tab (Host Recommended CTLE, 1 dB lower than 
optimal CTLE, or 1 dB higher than optimal CTLE).

3 Obtain sample or acquire signal data.

4 Set memory depth to capture the number or UI set in the Configure tab.

5 Set selected CTLE setting as per table 83E-2.
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6 Set Clock Recovery to First Order PLL with Loop Bandwidth = 10 MHz.

7 Measure the Eye Height A at an Eye Height/Width Probability setting of 1E-15.

8 Compare the measured Eye Width with 460mUI. Report the resulting value.

Eye Height B

Test Overview The purpose of this test is to verify that all of the following CTLE settings, Eye Height B is greater 
than 80 mV. CTLE settings are:

• Host Recommended CTLE

• 1 dB lower than optimal CTLE

• 1 dB higher than optimal CTLE

Pass Conditions Refer to Limits for Signaling Rate and Eye Mask Measurements.

Measurement
Algorithm

1 For the optimal CTLE, you may approach in one of the following ways:

• This setting can be characterized and automatically set by using the Find Optimal CTLE Eye 
Opening test under the Utilities in the Select Tests tab.

• Manually select the optimal CTLE setting from the Use Optimized CTLE for Eye Opening drop-down 
options in the Configure tab. The selected CTLE setting is called as ‘User-defined optimal CTLE’.

2 Select a configuration value for the Host - Recommended CTLE value setting in the Configure tab.

3 Obtain sample or acquire signal data.

4 Set memory depth to capture the Number of UI setting in the Configure tab.

5 Set CTLE setting to 1 dB lower than optimal.

6 Set clock recovery to First Order PLL with Loop Bandwidth = 10 MHz.

7 Measure Eye Height at 1E-15.

8 Repeat steps 3-7 with remaining CTLE settings – 1 dB higher than optimal CTLE and Host 
Recommended CTLE.

9 Compare the measured Eye Height B with 80 mV.
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Return Loss ENA/PNA/N1055A Measurements

The Return Loss ENA/PNA/N1055A Measurement procedures that are described in this section are 
performed using a Keysight Infiniium oscilloscope, PNA or ENA and the CAUI-4 Test Application. The 
Test Application controls the PNA/ENA/N1055A to set the test limits and run the tests. You must 
ensure that the connected PNA/ENA/N1055A is calibrated.

Figure 18 Selecting Return Loss Measurement Tests

Limits for Return Loss
PNA/ENA/N1055A

Measurements

The limits for tests under return loss PNA/ENA/N1055A measurements can be found in section 
83E.3.1.3 of IEEE 802.3 specification. Refer to Table 83E-1 for corresponding values.

• Differential Output Return Loss (see Eq. 83E-2)

• Common-mode to Differential Output Return Loss (see Eq. 83E-3)

Measurement
Algorithm (common

for both tests)

1 Ensure that the PNA/ENA is physically connected and calibrated.

2 In the Set Up tab of the Test Application, click Connect PNA or Connect ENA to establish connectivity 
to the connected equipment.

3 Click the Select Tests tab and check the tests to measure the Return Loss Measurements.

4 Click Run under the Run tab. The Test Application automatically calculates the return loss.

5 Compare the reported values with the specification to check for compliance.
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NOTE Use a test system that consists of a fourth-order Bessel-Thomson low-pass 
response with 33 GHz 3 dB bandwidth for all output signal measurements, 
unless stated otherwise.
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Main Voltage Measurements (pattern: Square8 or PRBS9)

The Main Voltage measurement procedures described in this section are performed using a Keysight 
Infiniium oscilloscope and the CAUI-4 Test Application.

Figure 19 Selecting Main Voltage Measurement Tests

Limits for Main
Voltage

Measurements

The limits for tests under main voltage measurements can be found in section 83E.3.1.2 of IEEE 
802.3 specifications. Refer to Table 83E-3 for corresponding values.

• Differential Output Voltage Test (max. 900 mV)

• AC Common Mode Output Voltage Test (max 17.5 mV)

• DC Common Mode Output Voltage Test* (-350 to 2850 mV)

* DC common mode voltage is generated by the host. Specification includes effects of ground offset voltage.
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Differential Output Voltage Test

Test Overview The purpose of this test is to verify that the peak-to-peak voltage of the differential signal on a 
PRBS9 pattern is less than 900mV.

Pass Condition Refer to Limits for Main Voltage Measurements.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Verify that the signal is connected, has TX enabled and has a PRBS9 pattern.

3 Measure the peak-to-peak voltage of the differential signal of DUT+ and DUT-.

4 Compare the maximum peak-to-peak voltage to 900mV.

AC Common Mode Output Voltage Test

Test Overview The purpose of this test is to verify that the common-mode voltage of the signal does not exceed 
17.5mV.

Pass Condition Refer to Limits for Main Voltage Measurements.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Verify that there is a signal and that the connection is dual single-ended.

3 Measure the peak-to-peak voltage.

• If the Test Application is running on the DSO Oscilloscope, the Instrument Setup is preset to Real 
Edge.

• If the Test Application is running on the UXR Oscilloscope, perform the measurement with the 
Instrument Setup set to Channels 1 and 2. Repeat the measurement with the Instrument Setup set to 
Channels 3 and 4.

4 Compare the voltage measurement with 17.5mV.

DC Common Mode Voltage Test

Test Overview The purpose of this test is to verify that the common-mode voltage of the signal is between -350mV 
and 2.85V.

Pass Condition Refer to Limits for Main Voltage Measurements.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Verify that there is a signal and that the connection is dual single-ended.

3 Measure the peak-to-peak voltage.

• If the Test Application is running on the DSO Series Oscilloscope, the Instrument Setup is preset to 
Real Edge.

• If the Test Application is running on the UXR Series Oscilloscope, perform the measurement with 
the Instrument Setup set to Channels 1 and 2. Repeat the measurement with the Instrument Setup set 
to Channels 3 and 4.

NOTE This measurement can be done only with dual single-ended connection but not 
with a differential probing connection.

NOTE This measurement can be done only with dual single-ended connection but not 
with a differential probing connection.
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4 Compare the voltage measurement to the range between -350mV and 2.85V.
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Transition Time Measurements (pattern: Square8)

The Transition Time Measurement procedures described in this section are performed using a 
Keysight Infiniium oscilloscope and the CAUI-4 Test Application.

Figure 20 Selecting Transition Time Measurement Tests

Limits for Transition
Time Measurements

The limits for tests under main voltage measurements can be found in section 83E.3.1.5 of IEEE 
802.3 specifications. Refer to Table 83E-3 for corresponding values.

• Minimum Output Rise Time (20% - 80%) (12ps)

• Minimum Output Fall Time (20% - 80%) (12ps)
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Minimum Output Rise Time (20%-80%)

Test Overview The purpose of this test is to verify that the minimum rise time is 12 ps.

Pass Condition Refer to Limits for Transition Time Measurements.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Verify that the signal is Square8.

3 Measure rise time from 20% to 80% of the signal amplitude.

4 Compare the minimum rise time with 12ps.

Minimum Output Fall Time (20%-80%)

Test Overview The purpose of this test is to verify that the minimum fall time is 12ps.

Pass Condition Refer to Limits for Transition Time Measurements.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Verify that the signal is Square8.

3 Measure fall time from 20% to 80% of the signal amplitude.

4 Compare the minimum fall time with 12ps.
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Signaling Rate, and Eye Mask Measurements (pattern: PRBS9)

The Signaling Rate and Eye Mask Measurement procedures that are described in this section are 
performed using a Keysight Infiniium oscilloscope and the CAUI-4 Test Application.

Figure 21 Selecting Eye Mask Measurement Tests

Limits for Signaling
Rate, and Eye Mask

Measurements

The limits for tests under main voltage measurements can be found in various sections of IEEE 802.3 
specifications. Refer to Table 83E-3 for corresponding values.

• Signaling Rate (25.78125 ±100 ppm GBd) (section 83E.3.1.1)

• Eye Height (228 mV) (section 83E.3.2.1)

• Eye Width (0.57 UI) (section 83E.3.2.1)

• Vertical Eye Closure (5.5 dB) (section 83E.4.2.1)
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Signaling Rate

Test Overview The purpose of this test is to verify that the signaling rate mean is between 25.78125 ±100 ppm GBd.

Pass Condition Refer to Limits for Signaling Rate, and Eye Mask Measurements.

Measurement
Algorithm

1 Obtain sample or acquire signal data.

2 Check that signal is connected and data pattern exists (PRBS9 must be used for this test).

3 Set memory depth to capture the number or UI set in the configuration tab.

4 Set data rate measurement to semi-automatic 25.78125 Gb/s.

5 Measure min, max, mean signaling rate.

6 Report min and max values.

7 Compare and report the mean signaling rate value to 25.78125 ±100 ppm GBd.

Eye Height

Test Overview The purpose of this test is to verify that for a defined range of CTLE settings, the Eye Height is greater 
than 228 mV. The CTLE values range from 1dB lower than the user-defined optimal CTLE to 1dB 
higher than the user-defined optimal CTLE.

Pass Conditions Refer to Limits for Signaling Rate, and Eye Mask Measurements.

Measurement
Algorithm

1 For the optimal CTLE, you may approach in one of the following ways:

• This setting can be characterized and automatically set by using the “Find Optimal CTLE Eye 
Opening test under the Utilities in the Select Tests tab.

• Manually select the optimal CTLE setting from the Use Optimized CTLE for Eye Opening drop-down 
options in the Configure tab. The selected CTLE setting is called as ‘User-defined optimal CTLE’.

2 Select which CTLE setting to test in the Configure tab (Host Recommended CTLE, 1 dB lower than 
optimal CTLE, or 1 dB higher than optimal CTLE).

3 Obtain sample or acquire signal data.

4 Set memory depth to capture the number or UI set in the Configure tab.

5 Set selected CTLE setting as per table 83E-2.

6 Set Clock Recovery to First Order PLL with Loop Bandwidth = 10 MHz.

7 Measure the Eye Height at an Eye Height/Width Probability setting of 1E-15.

8 Compare the Eye Height with 228 mV. Report the resulting value.

Eye Width

Test Overview The purpose of this test is to verify that for a defined range of CTLE settings, the Eye Width is greater 
than 570mUI. The CTLE values range from 1dB lower than the user-defined optimal CTLE to 1dB 
higher than the user-defined optimal CTLE.

Pass Conditions Refer to Limits for Signaling Rate, and Eye Mask Measurements.

Measurement
Algorithm

1 For the optimal CTLE, you may approach in one of the following ways:

• This setting can be characterized and automatically set by using the “Find Optimal CTLE Eye 
Opening test under the Utilities in the Select Tests tab.

• Manually select the optimal CTLE setting from the Use Optimized CTLE for Eye Opening drop-down 
options in the Configure tab. The selected CTLE setting is called as ‘User-defined optimal CTLE’.

2 Select which CTLE setting to test in the Configure tab (Host Recommended CTLE, 1 dB lower than 
optimal CTLE, or 1 dB higher than optimal CTLE).

3 Obtain sample or acquire signal data.

4 Set memory depth to capture the number or UI set in the Configure tab.

5 Set selected CTLE setting as per table 83E-2.
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6 Set Clock Recovery to First Order PLL with Loop Bandwidth = 10 MHz.

7 Measure the Eye Height at an Eye Height/Width Probability setting of 1E-15.

8 Compare the Eye Width with 570mUI. Report the resulting value.

Vertical Eye Closure

Test Overview The purpose of this test is to verify that the Vertical Eye Closure at EH15 (1E-15) is less than 5.5 dB.

Pass Conditions Refer to Limits for Signaling Rate, and Eye Mask Measurements.

Measurement
Algorithm

1 For the optimal CTLE, you may approach in one of the following ways:

• This setting can be characterized and automatically set by using the “Find Optimal CTLE Eye 
Opening test under the Utilities in the Select Tests tab.

• Manually select the optimal CTLE setting from the Use Optimized CTLE for Eye Opening drop-down 
options in the Configure tab. The selected CTLE setting is called as ‘User-defined optimal CTLE’.

2 Obtain sample or acquire signal data.

3 Measure the Vertical Eye Closure at an Eye Height/Width Probability setting of 1E-15 (EH15).

4 On the Oscilloscope,

a set the Clock Recovery to OJTF First Order PLL with Nominal Data Rate (25.78125 Gbps) and 
Loop Bandwidth to 10 MHz.

b Set 4th Order Bessel Thompson filter to 33 GHz with 3 dB gain.

5 Measure and calculate AV as the mean value of logic 1 minus the mean value of logic 0 at the 
central 5% of the eye.

6 Calculate Vertical Eye Closure (VEC) using the equation:

VEC = 20 log (AV/EH15)

7 Compare the Vertical Eye Closure with 5.5 dB. Report the resulting value.
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Return Loss ENA/PNA/N1055A Measurements

The Return Loss ENA/PNA/N1055A Measurement procedures that are described in this section are 
performed using a Keysight Infiniium oscilloscope, PNA, ENA or N1055A and the CAUI-4 Test 
Application. The Test Application controls the PNA/ENA/N1055A to set the test limits and run the 
tests. You must ensure that the connected PNA/ENA/N1055A is calibrated.

Figure 22 Selecting Return Loss Measurement Tests

Limits for Return Loss
PNA/ENA/N1055A

Measurements

The limits for tests under return loss PNA/ENA/N1055A measurements can be found in section 
83E.3.1.3 of IEEE 802.3 specification. Refer to Table 83E-3 for corresponding values.

• Differential Output Return Loss (see Eq. 83E-2)

• Common-mode to Differential Output Return Loss (see Eq. 83E-3)

Measurement
Algorithm (common

for both tests)

1 Ensure that the PNA/ENA is physically connected and calibrated.

2 In the Set Up tab of the Test Application, click Connect PNA or Connect ENA to establish connectivity 
to the connected equipment.

3 Click the Select Tests tab and check the tests to measure the Return Loss Measurements.

4 Click Run under the Run tab. The Test Application automatically calculates the return loss.

5 Compare the reported values with the specification to check for compliance.
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Find Optimal CTLE Eye Opening 74
TP4 Crosstalk Generator Amplitude Cal 76
TP4 Crosstalk Generator Transition Time Cal 77

This section provides the Methods of Implementation (MOIs) for the Utilities available for each 
combination of Standard Option and Signal Type to find the optimal CTLE Eye Opening.

NOTE Ensure that the Signaling Rate setting in the Configure tab of the 
Compliance Test Application must match the frequency of the acquired 
input signal.
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Find Optimal CTLE Eye Opening

The procedure described in this section to find Optimal CTLE Eye Opening are performed using a 
Keysight Infiniium oscilloscope and the D9010CAUC CAUI-4 Test Application.

Figure 23 Selecting Utilities under the Select Tests tab

Test Overview The purpose of this test is to loop through CTLE settings to find the optimal CTLE setting for the 
largest area of the Eye.

Measurement
Algorithm

1 Set the CTLE value to match the value set for the option Start value for CTLE utility for Eye Opening in 
the Configure tab.

2 Obtain or acquire signal data.

3 Set memory depth to capture 1 million UI.

4 On the Oscilloscope, Clock Recovery is set to OJTF First Order PLL with Nominal Data Rate and 

Loop Bandwidth. Set 4th Order Bessel Thompson filter to 33 GHz with 3 dB gain.
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5 Measure Eye Height and Eye Width.

6 Calculate area of the center eye using the formula EH1*EW1.

7 Repeat the previous steps for each CTLE setting until the CTLE value attains the value set for the 
option Stop value for CTLE utility for Eye Opening in the Configure tab.

8 Report the CTLE setting with the largest eye area. The Application automatically changes the 
configured CTLE setting to the optimal value.
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TP4 Crosstalk Generator Amplitude Cal

The procedure described in this section for TP4 Crosstalk Generator Amplitude Calibration are 
performed using a Keysight Infiniium oscilloscope and the D9010CAUC CAUI-4 Test Application.

Figure 24 Selecting Utilities under the Select Tests tab

Test Overview The purpose of this test is to calibrate the amplitude of the crosstalk generator.

Measurement
Algorithm

1 Manually configure the Crosstalk Generator.

2 Obtain or acquire signal data.

3 Verify that the signal is being generated and connected.

4 Measure the peak-to-peak voltage of the differential signal of DUT+ and DUT-.

5 When the Test Application prompts the message: “Your current amplitude result is <peak-to-peak 
voltage measured in the previous step>. Spec result is 900 mV. Do you want to change crosstalk generator 
and measure again (yes), or no to stop?”

• If you choose Yes, repeat steps 2 to 5.

• Choose No to end the calibration.
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TP4 Crosstalk Generator Transition Time Cal

The procedure described in this section for TP4 Crosstalk Generator Transition Time Calibration are 
performed using a Keysight Infiniium oscilloscope and the D9010CAUC CAUI-4 Test Application.

Figure 25 Selecting Utilities under the Select Tests tab

Test Overview The purpose of this test is to calibrate the rise time of the crosstalk generator.

Measurement
Algorithm

1 Manually configure the Crosstalk Generator.

2 Obtain or acquire signal data.

3 Verify that the signal is being generated and connected.

4 Measure the rise time from 20% to 80% of the differential signal of DUT+ and DUT-.

5 When the Test Application prompts the message: “Your current rise time result is <transition time 
measured in the previous step>. Spec result is 12 ps. Do you want to change crosstalk generator and 
measure again (yes), or no to stop?”

• If you choose Yes, repeat steps 2 to 5.

• Choose No to end the calibration.
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Uploading Results to Repository

The Upload Results To Repository feature is an add-on to the Keysight Test Application, where it 
expands the boundaries of storing and analyzing the measurement results to a wider audience, who 
may be based in multiple sites across various geographical locations. Along with the feature of 
exporting test results from the Test Application into your local disk in a CSV or HTML file format, you 
have the option to upload the test results to a Dataset on a Web Repository. Based on your 
requirements, you may either upload only a single measurement trial or upload huge volumes of 
measurement results to any Dataset.

Not only can remote users with an active Internet connection access these Datasets and the 
corresponding test results on the Web Repository, but they have the option to add and delete 
Datasets on the Web Server. In the Upload Results To Repository feature, you can even modify the 
Dataset properties, which are helpful especially when performing a graphical analysis of the 
uploaded data.

In combination with the Keysight KS6800A Series Analytics Software, the Upload Results To 
Repository feature provides a comprehensive solution to export, view and perform analysis of the 
measurement results, thereby resulting in qualitative data to ensure that the Device Under Test 
(DUT) is compliant to the industry standards.

Refer to the Keysight KS6800A Series Analytics Software Online Help for more information about the 
functionality of various features in this software.

To export measurement results to the Repository after the completion of test runs,

1 From the Test Application’s main menu, click File > Export Results... > Repository.



Keysight D9010CAUC CAUI-4 Test Application Methods of Implementation 81

Exporting Measurement Results to Repository 8

The Upload Results to Repository window appears.

2 In the Connect to Server pane of the Datasets tab, click Connect... to login to the Dataset Repository 
server.

3 In the URL: drop-down text field that appears, replace the default text with the actual IP address 
or the URL along with the port number, if applicable.

You may enter the URL of the Web Repository server, which may be a self-hosted server on your 
machine (http://localhost:5000/), a remote server or an authentication server. Note that all such 
URLs accessed via this window appear as a drop-down list in the URL: field.

4 Click the Check button to verify that the KS6800A Series Analytics service is available on the 
specified web address. Repeat this step each time you edit the web address.
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• For unrestricted access to the Repository

a If the server does not require authentication and the KS6800A Series Analytics service is found 
on the specified web address, the version information is displayed adjacent to the Check 
button.

b If you click OK, the Upload Results to Repository window displays the connectivity status to 
the Dataset Repository.

c Click Browse... to navigate directly to the URL.

• For restricted access to the Repository

a If service is found on the specified URL but access to the web server is restricted based on 
authentication, the version information is displayed along with the text Authentication 
Required adjacent to the Check button. Also, the Username: and Password: fields appear. The 
OK button remains disabled until the authentication credentials are entered.

b Enter the user credentials in the respective fields, which are required for authentication to 
access those Datasets that have been created on the web server you are connecting to. For 
each URL that you access, the Username: drop-down box keeps a record and displays all user 
names used to access the respective URL.
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c Click OK to connect to the entered URL/IP address.

The Connect to Server area displays the connection status along with the username.

d Click Browse... to navigate directly to the URL.

5 In the Select Dataset area, click Select... to view the list of Datasets created on the connected 
repository. Click Refresh to update the list of Datasets that appear in the Test Application's user 
interface.

6 Select the Dataset name where you wish to upload measurement results to. Click OK.



8 Exporting Measurement Results to Repository

84 Keysight D9010CAUC CAUI-4 Test Application Methods of Implementation

The Select Dataset area displays the selected Dataset as Active. The Measurements and 
Properties tabs are enabled after a Dataset is selected.
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7 Click the Measurements tab where the test results from the last test run are displayed.

8 You may select and export multiple test results to the repository. You may change the format for 
the display of measurement data using the drop-down options in the Group by: field.

9 After selecting one or more measurements, either click Upload or switch to the Properties tab to 
associate one or more properties to the measurements that are being uploaded to the Web 
Server.
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To perform an enhanced analysis on the measurement data using the KS6800A Series Analytics 
Service Software, Keysight recommends assigning properties to the measurements.
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10 Click the Properties tab to assign properties for your measurement results that you select to 
upload. By default, the App-Defined properties are selected to be uploaded in association with the 
measurement data, wherein only certain aspects of the selected measurements are uploaded. 
However, you may switch to Globals to include as properties one or more options configured 
under the rest of the tabs of the Compliance Test Application or define one or more custom 
property values to be associated with the selected measurement data.

11 Click Upload to begin uploading measurement results.

12 Click Close to exit the Upload Results to Repository window and to return to the Compliance Test 
Application.

You may access the Dataset Repository using the Internet browser on your machine to view the 
measurement results graphically on the KS6800A Series Analytics Service Software.
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KS6800A Series Analytics Service Software

The KS6800A Series Analytics Service software supports multiple data sources and also a wide range 
of data import clients. This web-based software provides various types of charts, such as Histogram, 
Box-and-Whisker, Line, Scatter, Eye Diagram and Constellation, each with split capability to enable 
data analysis. Once you upload the measurement results to a Dataset on the KS6800A Series 
Analytics Service Software via the Upload Results to Repository window of the Test Application, the 
measurement results can be viewed graphically as shown below:

For more information on the Data Analytics Web Service Software, visit KS6800A Series Analytics 
Service Software page on the Keysight website. You may refer to the Help manual provided within 
the software to understand the functionality of its features.

https://www.keysight.com/en/pd-2976519-pn-KS6800A/data-analytics-software?nid=-32976.1259666&cc=US&lc=eng
http://www.keysight.com/en/pd-2747984-pn-N8844A/data-analytics-web-service-software?cc=US&lc=eng
https://www.keysight.com/en/pd-2976519-pn-KS6800A/data-analytics-software?nid=-32976.1259666&cc=US&lc=eng
https://www.keysight.com/en/pd-2976519-pn-KS6800A/data-analytics-software?nid=-32976.1259666&cc=US&lc=eng
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9 Debug Mode

Debug mode can be selected to make enable the ability to change jitter measurement options. In the 
Configuration tab, select the Debug radio button. This will add the following options:

• Rj Bandwidth — Choose the Rj Filter. Options are Narrow (Pink) or Wide (White). This changes the 
amount of DC jitter in the Rj measurement.

• Jitter Pattern Length — Choose Periodic or Arbitrary. Periodic is used for data patterns that are 
periodic and repeat through the scope memory. Arbitrary is used for random data patterns or long 
data patterns (for example, PRBS31) that do not repeat through the scope memory. If Arbitrary is 
selected, set the ISI filters.

• ISI Filter Lead — When using Arbitrary mode for the Jitter Pattern Length, set the Leading ISI filter 
coefficient. To help select the correct ISI filter, see Application Note 1574: Choosing the ISI Filter 
Size for EZJIT Plus Arbitrary Data Jitter Analysis (at www.keysight.com, literature part number 
5989-4974EN).

• ISI Filter Lag — When using Arbitrary mode for the Jitter Pattern Length, set the Lagging ISI filter 
coefficient. Again, to help select the correct ISI filter, see Application Note 1574: Choosing the ISI 
Filter Size for EZJIT Plus Arbitrary Data Jitter Analysis.

http://literature.cdn.keysight.com/litweb/pdf/5989-4974EN.pdf
http://literature.cdn.keysight.com/litweb/pdf/5989-4974EN.pdf
http://literature.cdn.keysight.com/litweb/pdf/5989-4974EN.pdf
http://literature.cdn.keysight.com/litweb/pdf/5989-4974EN.pdf
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